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1.1 F=mIhgE

FAD-1160 /& —# S HIKG 2 B AR 515 5 % 1) PROFIBUS-DP {5,

1.2 R

> ZIIE: Zik 6 A E LA, AR ] R A A B RN

> RREE BOAASL 3 Z1RR S, RRAL 2 iE;

> RS AEE 0-20mA FI 4-20mA HLRAS TSR 1%, £EIIE 0-5V H1 0-10V H A SIS KE B A
5%0, HA TAT-HRAmH:

» PROFIBUS DP 75 HIGE N, i 12MHz;

» PROFIBUS DP 3 il 2 W,
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1.3 FFRmAEEERE

Zlpc/oc[— | PROFIBUS Fower |— +

S/ rezulato— _ [[9-30 VDC
v g e ] )
A - — &1 1L
comﬁ_d |~

ar CPU
Vo N
gOM _[j |~ T J’

/N — 16bit
= [l o
a7 i
COM‘_[) |~ ] E gom

d Ve
v o, \: ] :/ v
gom _ﬂ L~ >_ —< = E gOM

N\ S EN
B/ (A
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1.4 =g

ZH fH TR
Wi 6 ANIEIE, I8 IE ) AH BT
0-20mA,
4-20mA,
N
i NN 0.5V,
0-10V
LRI : 60mA,
= A\ 2
BRMAAS BRI : 200VDC
N 5 AL %if.ﬁiﬁﬁ)\:jso Q 4+ 1%,
55N BRI MQ
NS 50Hz. 60Hz
o RIS E] 1 404, e
BB Y 1000VDC
Bﬂ%ﬂ‘& /fﬁ:lj\ﬂ: mA
- <1% CHHAM=EM),
Hil <5%. CHE W=D,
IHER <0.5%0 CHiERD
A/D H 16 fif
FallET 3 50ms

DPVO, Mk, #7é&: IB/T

PROFIBUS DP #i7t
10308.3-2001

PROFIBUS U 4% FUE N, BRI % 12M

My R8s PROFIBUS Hh il EI%s
W T8 24 1) 2 Wi XRF
o MARISE] 1 20k, JWeR
b 8 A5 1000VDC GONT TmA
FYR AL FE L R 9-30VDC, 4.8W (max)
BRI 4.8W
A A et
T AR E -10~+70°C
- zjcﬁ%/ﬂ%‘ﬁ -60~90°C
24773 35mm 34
AME AT 105*86*60mm
Gigey 150g
Hhie LR
Bl 4745 4% P20
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BEfE Thie
Fa | R AP
WE | AR WESH

2.5 PROFIBUS DP 0
Bt 4©
s 50— GND (Pin 5)
PROFI_A (Pin 8) o © PROFI B (Pin 3)

o ST B
@)

O
10

O

PROFIBUS-DP 3 [13% 1] DB9 FLAY% K, HoleE Xan k.

51 155 Ui Bl

3 PROFI_B, ##siE (45
4 RTS

5 GND

6 +5V iyt

8 PROFI_A, #dlifn (4
B SHIELD, 4k HL4i B¢ il th

v PROFLB (51J13). PROFLA (5l 8) FIBtilch Ay 4z: RTS (51 4) nf Lgk—Lei 4 ok
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(1335 K% HH HLGE A 80mA
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2.6 BiE#ENO
24V+ O a
NC O 9 ~ 30V/DC
GND O -
27 BN
® Xﬂ'ﬂ:EEH_S %‘?iﬁ)\
V O
A O V Input 0~10V
0~5V
COM O

Hefl: —A 3 4l (PTRHYRZL, R 0-10V HURAF 54 BERIAIL—liE L.

0-10v/5v

V C transmitter
A O [
COM O . | power
® X THIUE T
Vv
A > A Input 0~20mA
4~10mA
COM O

ol —APIERICR S, 1iiE b
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KREASHE X

Add: PROFIBUS-DP &&kiuhl, BRI PROFIBUS Skiihl, JuHil 0~126

FRQ: M4, wT LA £ S0Hz TPk it 60Hz T

CHx VIR s SIS 2 SRS i 5 20 Sl s 2 A2l B, x FTROA 1. 24 34 4. 56
CHx 1) AL: 52 SCIIETE R A TR 5

0-5: 0-5v
010: 0-10v
020: 0-20mA
420: 4-20mA
CHx [ OUT: & SUZIMIE {55 M A i 4ok &R
FLO: UL IEEE754 % fi# = I E 2 (float point)4h t 4 A5 5 IIH
PCT: o ANfE 5 A 5 BRIt
CHx [ CAL: EIZIEIE OV (0mA), 4mA, 20mA, 5V, 10V. | ZiH) oMol renk, [N s
LR AT EERAEX LA i
CHx [ COF: {5, nI{E-5.0%0~+5.0%o (117 F Py X4 A M5 B 2EA T A BB IE .
CHx 1) FAC: K& IZ@IE ) BRIAME, %3168 T3 AL OUT, COF LU sk it S 20 BRIME

3.3 ThEeH AR
FAD-1160 & 6 A B3 (KL s N if i . JL=4F 8. Wil 1 Aol 2 /F 8 —4, 80 3 Al

W4 fEN—A, WIS A 6 1E o —2l. A SAZ MR [ —dlh PR S S Ik, X
LA A3 1T LUK b FL 7 AN 55 10 2 AR B N BN ] R 2R, 38 G 1 ATt o AN A5 T IR0 4
PROFIBUS /it 24 1 5 H A7 b 24

B 6 ANEIE BTG 5 RAE, R EER 2 e, WM . AR5 RS ANEE NS S
AN, A A AR SO BT A LARBE . 2455 PRODIBUS DP #EAT S04 A AR, ARl 122
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i N5 5 R AL HE 0~20mA,4~20mA,0~5V,0~10V, 328 AT 0 LA B %S 5. % 4ME PROFIBUS DP
RS, WLl SR E EIM R A, MAESEE S EE NI eS8 kE T E U
PROFIBUS &2k )% i #is, PRI A AR 5 2R a 2002 5 SEBR B NS 5 A — 5.
® itk

FEAS T W S A DI Rorkg X, VB ERE . SER Tl OUT S8 ke dia s ok Wikl
.

Vs Bk U2 B IEEE754 BIE 1R 2R 27 S B (R A5 5 {8

For L T S AR Gt MBI SEED *100%. 7 23 Hu i T R8Ok EoR .
® {5 SIS

T Y HER AR F AN 5 50Hz 5 60Hz )Tt S ) Frq 25 ) R AR 52 o MR A 43 2 kAT 410
il
® [k

FEAN I ) T HEAT A% 4, 280 COF YE T B IK R/, Al 455 B i B 19 -5%0~+5 %0 o
AR il GFAH0 =i N fH+ (COF*HEF2/1000)
® Il

AT 5 ) LAEAT BERE P 1 iR R TR o PR INERR N BE R 4~20mA TRFEIRIIN, 2% > & sl 2 A
HER N LU 20mA I IR . FIANTR 0~5V I, 2% ) i sl 2 AR HER N B SR 5V IR IR fE . v RCEEAT
AR 27 ST (R, A DRA AR 5 A LA e ARG A, 15 DU S5 5000 o AN A
o kI WHE

SR FAC # 3 BUZBIE M S HK B H ) I IBRME, AL SR R A
® K IWIE ML Wi

B R R SABIE A SR E KRR LR, &6/ TR (L 4-20mA JEED 8021
ERFEVEEIN . G SR fE e iR BRI, B /e i i A MBS R R o “HI,
P2 4-20mA N HARAALE S/N T 4mA,  TIERS A 2 B0 TE % A E SRR s “LO7.
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T BITET RERFH

o BEBRFERTIEE A, DARE HARIA ;

o BURFER A, A BRI A B T

o PO I B TS BRI, AR EBE IR

o BEBRFRRT EHEIK,  BEAR SRS R A

o TR AL, AT JCH R R

o BOREEA BRI, ERN SR L

o BIREOBEE R AAA SO, 15 A N BEIXAS SO R s
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7N RBUE R

AN A5 R4 R PR B AN S R AN T 2 Ao U 28 W) A5 7 i IR ARt R v, A7 AT REAE AN S
JURE DL R AT RO

SiboTech 1. 1z 5 36 BAAT IR A KM 47
P VRS N, P U A O RS O AN G B 2 A, AR T
N, A AR UE o

R A SRR A R ]
SiboTech Automation Co., Ltd.
BRI FF#:021-5102 8348
E-mail: support@sibotech.net

M hk: www.sibotech.net

www.sibotech.net 17 S i bO TeC h®


http://www.sibotech.net
http://www.sibotech.net

FAD-1160
##.2/PROFIBUS DP#

fs A T U B A E

PROFIBUS DP F 34 LAV []¥ S7 300 %41 PLC Jy il

Cy
1. §IJF SIMATIC Manager ﬂ :

SIMATIC
STEP 7
Version 5.4

SIEMENS

2. 1F File->New, #ridt—AN TR

.f SINATIC Nanager

o1

User projacts ll.-h-mu|

Base [ Storaxe path
TN BE:SSienans'\Step?\STprei\n

Haye
[Tk

Storage location (path)”
JE 53 menx\SapihSTpray

B
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3. Insert->Station->SIMATIC 300 Station:

{J STEATIC Wanager - Y WODRUS
v Inzevt FIC Vier Optiom:

lel-‘-"lw‘l Iu_lﬁl s l—_l _nl?:I_l - REERE =1%| 2=l ¥

2'.. T_RODEUS — H:\Siemens\Step?\STproj\Y_modbus

- 53 T_morEes
[& sTyarIc 300010

4. #IJF STPLC fififF &, SIMATIC 300(1)->Hardware, X{ifi:

W ISTNATIC Nanager - T_NODBUS

File Edit Inssrt TLC Yiew Options Windov Help

D || 27| & gg]qa]e_J dul [o %5 ofn || & (<o ~1%| =8| Ef”

E?’.".T_IODBUS E:\Siecmens\StepT\5Tproj\T_modbus

= &P T_MODEUS
-85 STRATIC 30011)

5. IE#I A FAD-1160 ¥ GSD 3Cff )5, SEHIE+E “Options->Update Catalog” , 1t Device HzxH
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EE M I . AR
PROFIBUS DP->Additional Field Devices->General->CONVERTER->FAD-1160

6. W& PLC rack, it “Hardware Catalog\SIMATIC 300\RACK-300\Rail ”:

:it,.t)on Edit Insert FIC View Options Windev Help =& x|
D[ (% & (e dldal =@ 2 el

& Profi ]Standard _:_]

[+ g5 PROFIBUS DP
=[] SIMATIC 300

w T
= > B #-(_] cP-300
Properties — PROFIBUS interface DP HMaster (R0/S2.1) [i] | | 5 O cu-300

Gemeral Pavamatars | (2] CPV 312 IFM

(2] CPU 313

Address: 12 vl If a subnet is selected, &) C:' CPU 314
the next_avnilable address is = C:l CFV 314 IFM

(2 CPU 315

= CPV 315-2 IP
8] eEST 315-2AF00-0ABD
Subnet: 8] eEST 315-24F01-0ABD
r BEST 315-2AF02-0ABO
(] BEST 315-2AF03-0AB0
BEST 315-2AFE2-DABO
[¥-(_] BEST 315-2AFE3-0ABO0
(2 cru 316
(3 cPU 318-2 TP
+-() CPV 318-2
(] CPU 514
[+ CPU W7
w1 m-300
w3 M-300
BE RE | #m | (2] IT-EXTERSTON
(1 Fs-300
| &) (2 FACK-300
I Rail
© w1 ( -300
@+ ] SIMATIC 400
[+ SIMATIC PC Based Control 300/4
[+ 48 SIMATIC PC Station

-

@

|<

&

S Nodule ... | Drder rumber ... | NPT adéress | I add... |Q address | Conment

I 3

< i |
BEST 315-2AF00-0ABO Al
48 ¥B work memory; 0.3 ns/

1000 instractions: MPI + D —
connections; for multi-tier

,,':"‘V

Ao || a|w|ro|—]:

%

Press F1 to get Help. ‘ ‘Chg

7. BOE CPU MEHR, 38X N K e 4 S AN BT ot AR R A 5

8. {# PROFIBUS DP M %%, 1% PROFIBUS DP: New->Network settings, £ DP, EF—
AN 187.5Kbps, SRJE “OK”, Xii:
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fie — [SINATIC 0(1) {Configurstion) —— T_RODBUS]

! wtetbem Jdiv Jaxery JIC Viee Qpticor findes Nelp _7q’1
Dl@e-8 (% & e b o %8 el
2 Brefi [Stwdard |
“+ Emmus 1P
| = @l sTIc 300
g o
Properties - PROFIBUS interface DP Naster (R0/S52.1) . ;8““
Generad FParametors | : :3] g: ::g =
> [2 ] If & sudaet ix select # ) CV 314
AdTas. = \h.mt_:u:;.:h':l':-’cn T #1 ] CFY 314 I
s Ocreans
= 2 cev 315-2 OF

SEST 315-2AFOC-0MED

SEST 315-2AK01-0XI0

3BST 315-24FNS-0AZD

® il SEST 315-2AF03-0XE0

% : SEST 315-2AXR2-0X20
1003, ..

ighest sR0FIES _ Ogtiona... | + L) $8ST 315-2AMBS-0AX0

? [z -] r
= = # ] cev 316

Propertics New subnetPROFIEDS

anaral Netvork Settings I

Tranzaixsion Bate:

45.45 (31.5) Fhivs
a3 15 ¥hit'e

W
_I | Profile:

< i = 3
fv:f::ﬁl /TNE) fus Parasaters. ] = L mck 9
Usar-Defined B it

o W + () 300

i+ simric <0

s |l wodue ... | Order tomber @ [l STMTIC BC Based Control 300/4
e | - l P ] i+ B STMTIC P Slation

v 1 < L1 |
BEST 315-2AY00-0ABD
B ¥P werk memery; 0.3 ax/

1000 instructiora; MPI ¢ DP
cticax. for multi-tier

¥

™o
-~

~i

RIS L B 2 L B

Ell

Press Fl te get Melp.

9. %# PROFIBUS DP Master station Hhdil:
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INATIC 300C1) (Configuration) ——
T \ ns f alp =] |
DIe-® Wl &) wle| | =@ % el

Edit In

King

2 Profi [Standara ]

[+ ¥ FROFIES DP
Select Profibus Address <[ STMATTC 300
& c7
[+ (1 CP-200
1= (L) cru-300
#-(J) CPV 312 IFM
[+ CPU 313
Address: =] If » subnet is selected, + (a P 314
the next available addressz 13 23} D CFU 314 IFM
Highest address!126 it (] PV 315
Tranzmizsion rate 187.5 kbit/z =] CPU 315-2 DF
[§] AEST 315-2AF0I-0ABO
i

Propertiez — PROFIBUS interface DP Nastex

General Faramaters I

Subnet:

=~ not networked ---

] GECT 315-2AF01-0ABO

| BEST 315-2AFO2-0ABO

FROFIBUS (1)

#-(_] BEST 315-ZAF03-0ABO

Froperties. .. REST 315-2AFA2-0ABO
e [#] (L] BEST 315-2AFR3-0ARO
—Dedate | ([ CRY 318

1+-{_]) CPU 316-2 DF
#-{_) CPV 318-2
#-{_] CPU £14
+ ( cPu MY
i+ (0 ¥m-z00
#{0 Im-z00
R ik hid:ul -] MT-FXTENSTOK
i+ (ZJ PS-200
i [ = = () RACK-300
2 Rail
© R {1 sm-z00
[l STMATIC 400
[+ [l SIMATIC PC Based Contrel 300/4
[+ B, SIMATIC FC Station

1%

By J Module ...  Drder pumber ... | MPL addrezsz I add .. Q addrezz | Commant

[>

< ) |
[BEST 315-2AF00-0ABD ~ £
46 KB work menory; 0.3 ms/ —1
1000 instructions: MPT + DP

connections; for multi-tier o

| a|a|wlr| =
l

=

‘rass F1 to get Halp. [ Chg

10. ¥ FAD-1160 #2512k I, BEif#7~ 13 B PROFIBUS DP M ki biik:

[SINATIC 300{1) (Cenfiguration)

=TT = A Y

| olx|
| Find:

PS 307 10A ks ’“'ﬂ""g

CPU 315-2 DP I (Erofil  |Standard b

2P
= ¥ PROFIBUS DP ~
EADGLIB0LD = (] Additional Field Devices i
= (1 General
= (L] CONVERTER
[+ g@ CPD-S11 IRV V1.0
[+ gg CPD-S11 TPV V1.0
FAD-1160 V1.0
Universal module
CHI AT
CHZ AT
L | ot
CHe AT
Properties. .. CHS AT

CHE AT
4' [+ g3 HEME10
Switching Devices
/0
S — J # (2 Gateway
+ (1] Compatible PROFIEUS DP Sle

@pl ® W\ 00 CiR-Object
# (1 Closed-Loop Controller

+ (] Configured Stations
+ (1 DP VO slaves
CPY 315-2 DP 2 4 0 P /as-i
oF 1023 < i >

"ﬁ»—uw V1.0 EJ

R i

General  Parsmeters I

Address:

Transmission rate: 1

[l o] | || en) [ o

=1

Subnet:

[ =@
=@

v

Insertion possible R

11. Huhb&s5e)a, Mgk L1 FAD-1160, 743 H 154 L £ Parameter Assignment JETI R, 7EIX
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12.

FAD-1160

##.2/PROFIBUS DP#

T E FAD-1160 5 3038 K15 A5 5 AR H AL . “ A7 SRR 5808,

4-20mA, 0-5V, 0-10V, No Action. JLH" No Action 27 24 i i 14 (1% A=

User Manual

% FE 0-20mA,
A A S RARCE

T AR P S ORI B . “Output” Rl DU R 8Ok KR 55 . “FLOAT” KR LA
() SEBREUAE R R s 2 AT L B, “ %7 R DUBRL & by 3 A5 5 30 B I 1 0 LU R 3R s 2 i R 42

- [o]x]

1 PS 307 104
2 CPU 315-2 DP
= Tl PROFIBUS (1): DP master systen (1)
4
5
5
7
5
9 P
10 L
11 3
General Parameter Assigment |
Parameters | Value
@ DP Interrupt Mode DEVD
[#(C) General TP parameters
{52y Devicaspecific paraneters
BRI 4 - 20nA
| [E] cH2 AT 4 - 20mA
gl | E oHs AT 0 - 107
| E o AT Wo Action
_}_l (7)  FAD-1160 V1.0 [E] Cr5 AT 0-5v
LB o T 4 - 20nA
|/@ P10 ... |Order Number / Designation |-[Z] CHI Dutput FLOAT
U @ CH2 Dutput FLOAT
1 [£] CH3 Output ¥
z | ] o4 Output Wo Action
3 [ _[E] OS5 Output %
1 | & cusoutpae
5 [#1{_] Hex parameter assigmment
Insertion possible

v

b3

| Eing: |

Profil [Standwrd  ~|

Cancel Help

8lx|

<

- ¥ PROFIBUS DF
=] Additional Field Devices
= (] General
=] CONVERTER
& CPD-S11 DPV1 V1.0 I
[+ g CPD-S11 DPV1 V1.0
FAD-1160 V1.0 [
@ niversal module
CHI AT
CH2 AT =
CH3 AT
CH4 AT
[{ o A
[ o ax
- gg HEme10
(] Switching Devices
=10
# (] Gateway
i+ (] Compatible PROFIBUS DP S1¢
03 CiR-Object
# (] Closed-Loop Controller
# (] Configured Stations
(] OP VO slaves

B3

3
3
3
E

.0 mP/as-i ™)
< | 3|
FAD-1160 V1.0 x|

¥ FAD-1160 37 #5711 %% N8
H 45— MODULE [fJ2aa b bl

D II' Conf:t( = [SIIAI'IC 300(1) (Cunfxguxatlon) == x]

[ JE

Edit Insert PIC View

nz findow Help

1# (MODULE) # A/ F AL, e <6, )

D= . @:z\éw hﬁ\\ﬁu\\ﬂjrﬂ\%&\k‘?\

————0|x|

E—

Insertion possible

1 PS 307 10A =
2 CPU 315-2 DP Erofil [Standard
PROFIBUS (1): DP master system (1

e ) ) ‘

[

S

6

T

8

3 Address / ID |

10 i

11 G - DB ER

~Input
<l - Cons
Start: E

_’ (1) FAD-11860 V1.0 End:
= . nr 10 ... |Order Number / Designation | I Add.. | @ Adaress | Conment EEECRss Bmdge) e =]

0 oiL AT b3

1 S |63

2 onz AT i, seps are

3 [CHe AT

Cancel

s |
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FAD-1160
=il 2/PROFIBUS DPi&E ik
User Manual |

13, Zpb, EPFAEE, JTGg 4L

nfiguration) — gl

=kt
PS 307 10A = Eind: Al

.
CPU 315-2 DP Profil [Standard =]
&

33
o
1%

- E ke

2 Tl PROFIBUS (1): DP master system (1) ?;ﬁ!h[ PROFIEUS DF
=1 (1] Additional Field Devices i
=] General
=1 (2] CONVERTER

. i + CPD-S11 DPV1 V1.0
Compile g

g3 CPD-S11 IPV1 V1.0
FAD-1160 V1.0
Universal module
CHI AT
CHz AT =
CH3 AT
CH4 AT
CHS AT
CHB AT

@ HEME10
#- (] Switching Devices
=310
- Gateway
# (] Compatible PROFIBUS DP Sl
&= o me-e vio T Cik-Object
#-(_] Closed-Loop Controller
S| [@ P10 ... |Order Nunber / Designation [T Add.. |Q Address | Comment ] 5@ Configured Stations

65

ICHI AT 0...3 #(0 D V0 slaves

65 CH3 AT a7 w0 npsas-; |
8
i

Station:

SIMATIC 300(1)
Module:

[0/2/0] CPV 315-2 DP

|| w|o|a|o|on|e]w

=|e

e )

53

<

2

BS [CH2 AT
65 [CH4 AT

il < i | &

Fress Fl to gat Help. ey

14. [9]2] SIMATIC Manager Jt1fi, 7 Block Wi II— M EEIRMIIE, —4 OB82, —/> OB86:

&) pile Edit Insert PLC View Options Hindow Help -8 %
| 877 | 4 B |dn| @ 25 @& || <Wo Filter >
|&)Systen data 3 0B1 3 0B82
SIMATIC 300(1)
] CPU 315-2 DP
-|-{s1] ST Program(1)
(3] Sources
(€Y Blocks
Organization Block
Function Block
” Function
Rewire. ..
Data Block
Compare Blocks. ..
Data Type
Reference Data 4
. VYariable
Check Block Consistency. ..
Print 4
Object Properties... Alt+Return
Special Object Properties 4
Inserts Variable Table at the cursor position. A
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User Manual

SINATIC NManager — [g — C:\Program Files\Siemens\Step7\sTprojigl

Bp rile Edit Insert PLC View Options Window Hel

D (8P| 5 B0 [de|o 25 %[ & |[ <Fo Filter > =Y | W& |HEM W

=l z JS)Systen data 3 0B1 3088-2 ﬂ.m-a'ss

= [ SIMATIC 300(1)
= [§ cru 3152 1P .
[=-(3] ST Program (1) Properties — Variable Table [;l
(B] Sources
(€0 Blocks General - Part 1 ]Gel\eral - Part 2 I Attribulesl
Name: IVATI
Symbolic Name: I
Symbol Comment: |
Project path: |
Storage location - - -
of project: |C:\Program Files\Siemens\StepT\sTprojig
Code Interface
Date created: 06/30/2011 10:34:46 AN
Last modified: 06/30/2011 10:34:46 AN 06/30/2011 10:34:46 AN
Comment :
=
Press F1 to get Help. I [PC Adapter (WPI) [ I )

15. Xikiix “VAT _17Elbr, {3 A ks “ Insert->Range of Variables”

N HF Confiz — TCTWATTC 20071V (0o fiososiooy __ 1

&:‘!SIIATIC Nanager — [g — \Program Files\Siemens\Step7\s7proj\gl

Edit Insert PLC View Options

@& || <¥o Filter > % |9E BEM N
o 0862 o 0856 WAVAT_L

Table Edit BESSSE PIC Variable View Options Hindow Help

-2 DPAST Progran(l)  [2)[E]X]

Ctrl+] D

Wl Inserts a range of contiguous addresses. Q 1U£ﬂ.ine [Abs {5.2 { /J

| JExess F1 to get Help. [ [PC Adapter (WPI) > [ A

16. fESLH T, ARAFAEIFOAZL, EPERAMIE. R HER AR R X LR

Hohik2 0, AREAEE (module FIHE) /&5, REMZEAIETFESE (float point):
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SINATIC 300(1) (Configuration) - . =1
"1Vaz - VAT_1

View Options Y¥indow Help
Table Edit Insert PLC Variable J Options Hindow Help
DSB8 Rﬁa\é\\hﬁ\\ﬁuﬂﬁla\%&\‘
=} wle| % 2 6|,
| Dlsle] 8] lmlef-|-] | sls) x| | Slelo] &l PP
x| - & e B
; T F'{VAT 1 — g\SINATIC 300(1)\CPU 315-2 DP\S7 Program(1) |[. [O|X]| at| i)
z CPU 315-2 DF | || sdaress] sracor] pispiar formet| statu: =
1z oF f
3 S 3 &
1 Insert Range of Variables \ evices
5
3 As of address: pid0 3:
T Vi V1.0
: Hunber : [ =] pouble tora(s) Vi VIO
L] Display format: 1.0
0 sal module
i1
Modi £y value:
Lo ] ’
<l ik
BUS DP Sl
”
| 1) FAD-1160 V1.0
- Press Fi for help. @ Dffline [abs <5.2 i
S| 1P .. |Order Number / Designation | T Add.. |0 Address | Comment @3 Configared Stations
0 65 [CH1 AT 0...3 (] TP V0 slaves
1] e lcHs AT 7 o (2 P Aac-i |
2| & lcrz_ AT B.11 £l i |3
3| 65 [cre AT f27zis
X
Press Fi to get Help. ]

7t Manager Ftif b iy FECEIbR, FAEAS TR T 4% PLC s

Ga \Progru Fxles\Slexens\Step?\s?pxn]\g]

BT 4 B @9 %% |[ <o Filter > Zv | BE | BEmR)
= =IES]
llg Her dware i 2 TP — |

SIMATIC 300 (1) ﬂﬂ]

CPU 315-2 DP =

= (&1 ST Progran(1)

@ Soirees

o]
(€3 Blocks 1d Devices

i
Download (13:4469) 3] 1RV VL0
- 11 DPVL VIO
Do you want to delete the system data in the Le0:¥1o0
! progranmable controller completely and iversal module

replace them with offline system data? 1 AT

2 AT _

I™ Do not display this message sgain. CZ ﬁ

s AT

& AT

o

evices

Ho Cancel Help |

=i PROFIBUS DF S1¢
s

ntroller
ions

Press F1 to get Help. [PC Adapter OIPL) [ [ /A
Press F1 to get Help. [

18. PROFIBUS DP i#ifi 5, i “VAT 17, fidi &G KA ALEE . W N E s fAr
MODULE [ )& chl,ch3,ch2,chd,ch5. %1835 1% A A Ry S AAE T B 2200 1y St i A omg DA
FH, AMWEWALE DT Bos BUE S B 1 SAR R R RIEIE 1 AL 12.0849mA; 2 5

SiboTech’
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AP B RONIEIE 3 MR NS 5B 1 30.24243%; 3 S AR ER N IE 2 N
12.10038mA; 4 SAFE FR/~TBIE 4 MR 3.017755V (4 3818 A5 5 20 R0 Sy 28

BB E D 5 SR RRRIEIE 5 A HL IS A7 He A A5 5 Y LR 60.39473%

: EEX:
Table Edit Insert PLC Varisble View Options Hindow Help

| il & &[mlelol-| x| P2l | e sl o

Properties — DP slave

Ll
P ter Assi t
| ddress | Sraboi| Display format | status value| Modifr value| Gamerald [Pttt iehestpmeat]
[ PID 0 FLOATING_POINT El| Paamsien Vake ¥
=| PID 4 'FLOATING_POINT  30.24243 (=3 Station paraneters = i
3| P 8 'FLOATING_POINT 38 [-[] DP Interrupt Mode DEVO
T P 12 'FLOATING_POINT  3.017755 il Sener sl DR puzsne tirs
5| P 16 'FLOATING_POINT  60.39473 | TE ot At 4~ 20al
[k 1 | 3 il L@ CH2 AT 1 - 20mA
H LE]C}BAI .
L@ CH4 AT No Action =
LB o AT 0-5v
L2 o A 4 - 20nh
‘—EI CHI Dutput FLOAT
L@ CHZ Qutput FLOAT
L@ CH3 Dutput B3
L@ CH4 Output No Action
L@ CHS Output % =
L2 o5 Output FLOAT
22 Hav. navematar azeienment ]
\SINATIC 300 (1)\.. . \ST Progran (1) [ <O T ws <52 ) LI &I M
— ¥ Conpatible FROFIBUS DF SIt
:]!J (7)  FAD-1180 V1.0 09 CiR-Object
(] Closed-Loop Contreller
3. ..lm’ ID ... | Order umber / Designation I Add .. |Q Address | Comment ] - Configured Stations
B85 ICH1 AT 0...3 (] DP V0 slaves
65 CH3 AT 4...7 @0 TP /as—; |
65 Ci2 AT 8. .11 <l i | &
B85 [CH4 AT 12...15 {(
B85 ICHS AT 16...19 =
| ———
| Press F1 to get Help. | Y
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i3k B W EFZ#E R

AP RIEWHE R, AR step7 P T EGLWIEE. T MHIFZE X S7-317-2PN/DP 747
T PLC, 1 SIMATIC Manager (c) STEP 7 S7/M7/C7 [RAJ V5.4+SP4, FAD-1160 [¥] PROFIBUS DP M\
s 1.

NI A 6 ANEIE 12 W

L FTJFIRR, T Ik s

KJ STNATIC Manager — [PCO-150S_schex 1 —— G:\my work\Projects\pc—150\PCO—1505%EE MR \PCO-1505]

% File Edit Insert PLC VYiew Optidns Window Help -
D |37 & a2 g2 % %[ f @ |] <Fe Filter > % Be BEMN
"= Bp Pro-1505_cchen_ [l Har dwars [ CFV 317-2 FN/IF
[=-(z2] 57 Program(1)
(B Sources
@ Blocks
Press F1 to get Help. TCB/IP -> Realtek RTL3139/810x F| f j 30,08
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2. FEBUNEES STEPT 84 “PLC->Diagnostic/Setting->Hardware Diagnostics”

; : PCO 0 . . DAPCO | z
% File Edit Insert Yiew Options Window Help
‘ D | 32& | & Access Rights Filter > ~ | | 28 . |!
= &P PC0-150S_schem_1|  Download Ctrl+L

= SIMATIC 30001 . ¢ ue Ctrl+K

= [§ cpu 3172
=-{1] ST Pro¢
(B Sow

€] Ble

Compile and Download Objects. ..
Upload to EG

Upload Station to PG. ..
Copy RAM to ROM. ..

Dow

oad User Program to Men

Save to Memory Card

Retrieve

Manage N

Display Accessible Nodes

Change Module Identification
CPU Messages. ..

e Yalues

Moni tor/Modi fy Variables

Display Forc

Diagnostic/Setting

Hardware Diagnostics
Module Information. ..
Operating Mode. ..
Clear/Reset. ..

Set Time of Day...

Hode Flash Test

Ctrl+D
Ctrl+I

PROFIBUS 4
Edit Ethernet Node...

e Firmware

Update the Operating System

vice Data

save bHe

FH AN R EAE -
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Hardware Diagnostics — Quick ¥View

Path: IPCU'15US_S chem_1%\SIMATIC 300(1)
CPU/Faulty Modules

Module Addr. | DP IEr RS | |lodule Information...|
Elee 0 o
B2 DF Slave E 8188  1(1) - - -

Ipenn Station ONLINE.. l

Update ]

[V Display Quick View during hardware diagnostics

Close I Help |

3. ik FAD-1160 X M [ ki, @i R, it “Module Information...” %4l

Hardware Diagnostics — Quick View

Path:  |PCO-1505_schem_1\SIMATIC 300(1)

CPU/Faulty Modules

Module adar.  [mp [P [R5 [tedule Information P
- = - o 2

[AY0P Slave E 5188

Ipen Station ONLINE. . <|

Update I

v Display Quick View during hardware diagnostics

Close I Help |
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4. FH IR XEHE, A “OK” %4

Hardware Diagnostics — Quick View (11...

he inserted module and the configured module
are not identical.

Help I

5. BT FXHEHE, EFE “DP Slave Diagpostics” #x

Path:
Status:

Operating mode of the CFIU:

@RU'N

Desecription: DF Slave System FROFIBUS DF
AR Order No./ Descrip... | Component | Version
DF master system: 1 Address: I 5188
Station: 1
Status: Module configured, but not available

Preset/Actual mismatch:

(inserted and configzured module types are not the same)

Close I Update Pranmtts: Help |
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WM RE, fiidi “Hex Format...” %40

Path: lPCU-lSOS_schem_l \SIMATIC 300(1)% Operating mode of the CFPU: @ RUN

Status: 974 Error

General DF Slave Diagnostics I
Master 2 @imufacturer' s 16# 0187

Standard Diagnostics of the Slave:

Slave-specific diagnostic data
Watchdog activated

Channel-Specific Diagnostics:

Slot | Chann... | Error

Help on selected diagnostic row:

Close I Update l Print. .. I Help I

7. SRR B IEAE, OGRS 6 ANl 6 NMEIERZIKE S, R NETE AT

Diagnostic in Hexadecimal Format

DF slave diagnostics:
0000 ;08 0C 00 02 01 87 0A 82 00 0@ 01 01 01 0F >

I Close I Print. .. Help I

0000 : 08 OC 00 02 01 87 OA 82 00 0001 01 01 01 01 01
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8.  LFEMEG 6 NI MNAERIAMK IR HIEE 1. #iE 2, Wi 3. W4, Wil s MiEEe. & FAE
i) 6 NFATE R 01, HERIRMAGE ST g R G ARAG .
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